
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

Speiros v1.0 
 
 

User Guide 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: FOR AN OVERVIEW OF THE SPEIROS VISION 
AND CYRUS INTERSOFT, LOG ON TO THE WEB SITE AT 
WWW.CYRUSINTERSOFT.COM 

 
 

January, 2000 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

2 

Speiros v1.0 User Guide 
January, 2000 
 
NOTE: FOR AN OVERVIEW OF THE SPEIROS VISION AND CYRUS INTERSOFT, LOG ON TO THE 
WEB SITE AT WWW.CYRUSINTERSOFT.COM. 
 

Table of Contents 
 

PART 1. INTRODUCTION.............................................................................................. 5 

Introducing Speiros ...................................................................................................... 5 

Pervasive Computing ................................................................................................................................. 5 

Java .............................................................................................................................................................. 5 

Speiros Advantages.................................................................................................................................... 6 

Speiros Virtual File System .......................................................................................... 8 

Naming ......................................................................................................................................................... 8 

Resource Naming........................................................................................................................................ 8 

File Naming Advantages: ........................................................................................................................... 9 

Local File System...................................................................................................................................... 10 

Speiros Interprocess Communication .................................................................................................... 10 

PART 2. SPEIROS INSTALLATION ............................................................................ 11 

Downloading Speiros.................................................................................................. 11 

Installing Speiros ........................................................................................................ 11 

Logging on to Speiros ................................................................................................ 13 

PART 3. USING SPEIROS ........................................................................................... 14 

Using the Speiros Bar................................................................................................. 14 

Installing/Updating Speiros Utilities.......................................................................... 14 

Mount Another Server .............................................................................................................................. 14 

Customize the Appearance of the Speiros Bar...................................................................................... 15 

Modify Your Speiros Bar Orientation...................................................................................................... 15 
Modify the Size of Your Speiros Bar ........................................................................................................... 15 
Show or Hide File Names on Your Speiros Bar.......................................................................................... 15 
Request Confirmation Before Exiting Speiros............................................................................................. 15 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

3 

Using the Task Monitor............................................................................................... 16 

Monitor or Check the Status of a Task ................................................................................................... 16 

Terminate a Task or Resource................................................................................................................. 16 

Using the Speiros File Browser ................................................................................. 17 

Managing Files and Folders..................................................................................................................... 17 
Display the Contents of the Home Directory............................................................................................... 17 
Display the Contents of Any File or Folder ................................................................................................. 17 
Open a Document or Program File ............................................................................................................. 17 
Copy Resources, Files, or Folders to Other Folders, Drives, or Servers ................................................... 18 
Create a New Folder ................................................................................................................................... 18 
Rename a File or Folder ............................................................................................................................. 18 
Find a File or Folder .................................................................................................................................... 19 
Delete a File or Folder................................................................................................................................. 19 
View File Properties .................................................................................................................................... 19 

Open a Duplicate Window........................................................................................................................ 19 

Customize the File Browser Display ....................................................................................................... 20 

Selecting the File Browser View.............................................................................................................. 20 

The Tree View ............................................................................................................................................ 20 
Resize the Columns in the Directory Tree .................................................................................................. 20 

The Split View............................................................................................................................................ 20 
Resize the Panes in the Split View ............................................................................................................. 20 

The Contents Tray View ........................................................................................................................... 21 

Customize the Contents Tray Display .................................................................................................... 21 

The Details View........................................................................................................................................ 21 

The Column View ...................................................................................................................................... 21 

Show or Hide the Toolbar......................................................................................................................... 21 

Creating a Custom View ........................................................................................................................... 22 

Using the Catalog Browser ........................................................................................ 22 

Selecting an Alias ..................................................................................................................................... 23 

Navigating Through the Categories ........................................................................................................ 23 
Navigate Up 1 Category.............................................................................................................................. 23 
Go to the Top .............................................................................................................................................. 23 
Use the Parent Category Navigator ............................................................................................................ 24 

Display Alias or Category Information.................................................................................................... 24 

Make the Current Catalog the Default..................................................................................................... 24 

Reload All of the Alias or Category Information.................................................................................... 24 

Working With Your Personal Catalog ..................................................................................................... 24 
Open Your Personal Catalog ...................................................................................................................... 24 
Adding Aliases to Your Personal Catalog ................................................................................................... 25 
Create a New Category............................................................................................................................... 26 
Removing an Alias From Your Personal Catalog ....................................................................................... 27 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

4 

Changing Passwords.................................................................................................. 27 

Launching Aliases....................................................................................................... 28 

Using the Speiros Bar............................................................................................................................... 28 

Using the Task Monitor ............................................................................................................................ 28 

Using the File Browser ............................................................................................................................. 29 

Using the Catalog Browser ...................................................................................................................... 29 

Adding Favorite Aliases to Your Speiros Bar........................................................... 29 

Using the Speiros Bar............................................................................................................................... 29 

Using the File Browser ............................................................................................................................. 30 

Using the Catalog Browser ...................................................................................................................... 30 
 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

5 

PART 1. INTRODUCTION 
 

Introducing Speiros 
 

Speiros is a software technology that: 
 

δδδδ provides on demand delivery of application, data and computing services throughout the 
Internet. 

 

δδδδ can be used from any Java enabled computing device with an Internet connection. 
 

δδδδ provides a single consistent technology that runs across all technologies, platforms and 
networks. 

 

δδδδ is platform independent.  Speiros is a preintegrated computing system that runs over the 
Internet. 

 

δδδδ provides private, secure network computing over the Internet. 
 

δδδδ transcends traditional computer, corporate and industry bonds. 
 
 

(pic) 
 
 
 

Pervasive Computing  
 

Anytime,  
 

Anywhere, 
 

Any hardware,  
 

Any operating system 
 
 
 
 
 

(pic) 
 
 
 

Java 
 

Java is a machine independent programming language. Almost any device that has a 
computer can run Java.  More and more, manufacturers are taking advantage of Java’s 
universal programming power and producing their products to run Java.  Speiros takes 
advantage of Java’s platform independent features to create a single consistent 
technology that runs across all technologies, platforms and networks. 
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Speiros Advantages 
 
Virtual Desktop 

 
Through the Internet, Speiros allows you to access Java based applications.  Spreadsheets, text 
editors, graphics tools no longer need to be loaded on your machine or your local network.  You 
can access these applications through the Internet. 
 
You can save files locally to your machine or via the Internet on any storage device your 
Presence is connected to. 
 
Speiros makes the virtual desktop a reality.  You can access applications and save and retrieve 
data from any Java enabled device with an Internet connection. 

  
 
 
 
Mobility  

 
Through any Speiros device hooked up to the Internet, you can access your Presence 
and have access to your data, applications and other resources.  With Speiros,  you can 
access the same data and applications through your office computer as you can through 
your home computer or your cel phone or cable box.   

 
 

(pic) 
 
 
 

Cross Platform/Cross Device Implementation 

 
Speiros can operate on any device that runs Java. Cel phones, PCs. Macs, Unix 
machines, handheld computers, set top (cable) boxes, embedded devices in automobiles 
like GPS systems, radios, cameras – almost anything that has a computer.  Because the 
Speiros technology takes up so little memory, it can be loaded on almost any device. 

 
 

 Centralized Resource Management 

 
Since you can store files on your Speiros server, your Presence acts as a virtual hard 
drive.  Wherever you have access to the Internet, ,  your applications and data are 
available. With your Presence centralized on your server, you can also easily 
exchange files within your office or anywhere in the world. 

 
 

Customizable Internet Interface and Configuration 

 
Sperios allows users and companies to define their own interface to the Internet.  With 
Speiros, you can select Internet resources and configure them to meet your personal 
and professional needs.  You can specify which Java based applications you need to 
launch and identify where you wish to store data. 
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(pic) 
 
 
 

 
Increased Efficiency in Software Upgrade Distribution 

 
Tired of going from one device to the next or one server to the next upgrading software.  
With Speiros, applications are available over the Internet.  When the Java based 
application is upgraded by the application developer, you automatically get the updated 
version the next time you use it.  No messing with hard drives, configuration files or chip 
sets.  With Speiros, applications and data on traditional embedded devices such as cel 
phone can be updated without changing the chip set! 

 
Shifts Software Development Cycle Paradigm 

    
With Speiros, software developers can distribute their Java based applications 
over the Internet.  Developers simply put a new version of the application on their 
server and they’ve released a new version that any Speiros device can access 
and use.  The software development cycle will change since releases can be 
more frequent without the hassle of packaging and distribution. 

 

Metering – Pay-Per-Use 

 
Speiros provides a unique and powerful pay-per-use option.  Users can pay for the time 
or frequency they use Java based applications.  For users, the pay-per-use option allows 
them access to software without the cost of  purchasing the software, the hassles of 
waiting for the software to arrive or travelling to the nearest software retailer and installing 
the application.  Instead of paying a substantial price for an application the user may only 
need for a short time, the user can “rent” the application through the Internet.  For 
developers, the pay-per-use option allows them to reach a wider audience, people who 
would not normally pay the full price to purchase the developer’s software. 

 
Flexibility - Works with Existing Equipment and Infrastructure 

     
Speiros doesn’t require you to buy new network computers.  Since Speiros is Java 
based, it will work with your existing infasructure and allow you to switch between Speiros 
and your Windows, Mac or UNIX environments. 

 
Ability to Run Multiple Java Applications Simultaneously 

 
Most computers only allow you to run one Java application at a time.  With Speiros, you 
can run multiple Java applications simultaneously. 

 
Access Web Resources without a Browser 

 
Speiros can launch any Java based application and access Internet resources without a 
browser.   
 

Client Server 

 
With Speiros, you can create client server applications through the Internet. 
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Promotes Collaboration, Facilitates Communication 

 
The origins of network computing was based upon the need to bring people together in a 
computing environment.  Speiros allows users to share directories, files and applications 
over the Internet.  Sally on her cel phone in Saskatchewan can make changes to a file 
and that exact file is then available to Murray on his laptop in Madagascar. 

 
3 Levels of Security 

 
Speiros provides 3 levels of security; network access authentication, permission settings 
and device security. 

 
 

Speiros Virtual File System 
 

Speiros’ Virtual File System closely resembles other file systems.  Through Speiros, you can view 
any files and resources on your local Java enabled device as well as files and resources located 
on your Speiros server. 
 

You can create folders, copy files and folders, delete files and folders in a similar manner as 
other file systems.  See the Managing Files section of this manual for more details. 

 
Naming 
 

Speiros closely follows Internet (URL) naming conventions  for its file system. 
 
Speiros provides globally unique path names by using the server's fully qualified domain name 
plus server's file system for directories. 

 
 

Example 

 
Server Domain Name circus.net 

Server’s file system  /home/larry/ 

File Name myfile.txt 

Speiros Path Name /circus.net/home/larry/myfile.text 

Resource Name file:///circus.net/home/larry/myfile.text 

 
 

Resource Naming 
 

Speiros uses universal resource language (url) naming conventions for resources.  

 
 
Address http://www.cyrusintersoft 

Device   

File Name file:///circus.net/home/larry/myfile.text 

 
 

The Additional Forward Slash Means Start at the Root Directory 

 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

9 

When referring to resources on the Speiros server, an extra slash is needed to designate the 
root directory. 

 
  Example: 
 

A UNIX system file normally has the // designation after the file resource 
designation. 

 
   file://home/larry/myfile.text 
 

The Speiros file has an additional slash at the beginning, plus the name of 
the server. 

 
   file:/// circus.net/home/larry/myfile.text 

 
 
File Naming Advantages: 
 

Unique Pathnames 

 
By including domain names and the server’s file system, Speiros ensures no two 
pathnames will be the same. 

 
   /circus.net/home/larry/myfile.text   
 

instead of  
 
/circus.net/home/myfile.text 

 
Troubleshooting 

 
Administrative and troubleshooting personnel are given critical information system just 
from the unique path name.  The server, file system and file names are all known. 

 
 

Special Cases 

 
If user has same server mounted twice under a different user, the pathname given will be 
preceded by an @ symbol, user and the number of times the user has mounted the server. 

 
  Example: 
 
  When the user first mounts the circus.net server, the pathname is: 
 
   /circus.net/home.larry/file.txt  
 

When the user again mounts the circus.net server (without  
dismounting), the pathname is:  

 
  /user2@circus.net/home.larry/file.txt 
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Local File System 
 

For local files, Speiros uses the local file system.  This allows administrators and users to 
take advantage of the local file system’s utilities. 

 
(pic) 

 
 
 

 Home Directory on Speiros Server 

 
When you connect to a Speiros Server, your account has a Home directory. The first time you log 

into Speiros, Speiros automatically creates your Desktop and Config directories. 
 

Home/User/Desktop Directory on your Speiros Server 

 
The Speiros Bar displays a button for each file listed in the Desktop directory.  See the Adding 
Favorite Aliases to Your Speiros Bar section of this manual for more details. 

 
Home/User/Catalog Directory on your Speiros Server 

 
The first time you launch the Catalog Browser, Speiros automatically creates your Catalog 
directory.  See Using the Catalog Browser section of the manual for more details. 

 

Speiros Interprocess Communication 
 
Speiros uses TCPIP/Port 3000. 
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PART 2. SPEIROS INSTALLATION 
 
 

Downloading Speiros 
 
1. Log on to Cyrus Intersoft at www.cyrusintersoft.com and click on the Get Speiros Button. 
 
                                         (pic) 
 
The Download Speiros page appears. 
 
                                         (pic) 
 
2. Select the correct platform for your machine from the Drop-down List in the Step One Box. 
 
3. Enter your name and email address in the Text Fields of the Step Two Box. 
 
4. Click the Download Button in the Step Three Box. 
 
The Download Acknowledgment page appears. 
 
                                        (pic) 
 
5. Save spinstall.exe in the location of your choice.  This is the program that will install Speiros. 
 
 

Installing Speiros 
 
1. Go to the location where spinstall.exe was saved and double-click on the executable. 
 
The InstallAnywhere utility appears. 
 
                                         (pic) 
 
2. Click on the Next Button to proceed. 
 

Note: Clicking on the Exit Button at any time will end the install process and close the utility.  

 
The License Agreement window appears. 
 
                                         (pic) 
 
3. After reading the terms, click on the Yes Radio Button to proceed. 
 

Note: Clicking on the Previous Button will take you back to the previous screen.  

 
The Choose Install Folder window appears. 
 
                                         (pic) 
 
4. The utility automatically creates a Program File to install Speiros in.  You can: 
 

δδδδ Use this location and click on the Next Button to proceed 

δδδδ Type in your own location in the Text Field. 
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δδδδ Click on the Choose Button to browse for another location 
 
The Browse for Folder window opens. 
                                                       (pic) 
 

Note: Clicking on the Restore Default Location Button will restore the location originally created by the 
utility. 

 
5.  Once a location has been established, click on the Next Button to proceed. 
 
The Choose a Shortcut Location window appears. 
 
                                         (pic) 
 
6. You can: 
 

δδδδ Use the default selection of the In an existing program group Radio Button and click on the 
Next Button to proceed 

δδδδ Select another program group from the Drop-down List 
 
                                         (pic) 
 

δδδδ Select the In a new program group Radio Button and type in the location in the Text Field. 

δδδδ Select the In the Start Menu or On the Desktop Radio Button 

δδδδ Select the Other Radio Button and click on the Choose Button to open the Browse for 
Folder window 

δδδδ Select the Don't create shortcut icons Radio Button 
 
7. Once a location has been established, click on the Next Button to proceed. 
 
The Choose Java Virtual Machine window appears 
 
                                        (pic) 
 
8. You can 
 

δδδδ Use the default selection of the Install Javasoft JRE Radio Button and click on the Next 
Button to proceed 

δδδδ Select the Choose a virtual machine Radio Button and click on the Search Button (the utility 
will search your hard drive for existing VM and list them in the window) 

δδδδ Click on the Choose Another Button and to open the Browse for Folder window 
 
9. Once a Java Virtual Machine has been established, click on the Install Button to proceed. 
 
The Install Status window appears. 
 
                                         (pic) 
 
When the installation is complete the Install Complete window appears. 
 
                                          (pic) 
 
10. Click on the Done Button to close the install utility. 
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Logging on to Speiros 
 
1. Locate Speiros in the shortcut location you established and double-click on it. 
 
The Speiros Login Dialog Box appears. 
 
                                              (pic) 
 
2. Enter the Speiros Center provided by your instructor in the Speiros Center Text Field. 
 

Note: The next time you log in, the same Speiros Center will appear by default in the Text Field and a list 
of all the Speiros Centers you have logged into will be created in the Drop-down List. 

 
3. Enter your username in the Username Text Field. 
 
4. Enter your password in the Password Text Field. 
 

Note: You can change your password later using the Change Password Tool in your Speiros Presence. 

 
5. If applicable, select your Aspect from the Aspect Drop-down List. 
 
6. Once all the fields are complete, click on the Connect Button to proceed.  The Status Bar will 
show you the progress of the connection.  
 

Note: Clicking on the Cancel Button at any time will close the Login without completing the operation. 

 
When the connection is completed, the Speiros Bar will appear on your Desktop and you can begin 
using Speiros. 
 
                                                                            (pic) 
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PART 3. USING SPEIROS 
 

Using the Speiros Bar 
 
The Speiros Bar is an interface for using Speiros.  It appears after you have successfully logged into 
Speiros.  This is your starting point to launch applications, browsers, and any other resource. 
 

Note: Tool Tips appear when you hover your pointer over any object in Speiros. 

 

Installing/Updating Speiros Utilities 
 
Cyrus Intersoft has a number of utilities that provide basic functionality.  They are distributed to the you 
via the Speiros Updater.  
 
Currently, these utilities are available for Speiros: 
 

δδδδ Task Monitor- Displays all of the active tasks in operation and allows you to launch individual 
tasks as well as terminate them 

δδδδ Web Browser- Browse the Web 

δδδδ File Browser- Manage the contents of your local drive as well as file systems on remote 
servers 

δδδδ Catalog Browser- Displays and edits the contents of a Catalog  
 
To install or get the latest version of the utilities: 
 

1. Click the Speiros Start Button and then select Updater Sites in the Start Menu. 
 
 

The Updater Dialog Box appears with the list of available utilities. 
 
|                                                  (pic) 

 
2. Click on the Check Box for each utility you wish to update or install.  A check mark appears in 

the box to enable the option. 
 
3. Click on the Update Button and a Progress Indicator appears. 

 
                                                       (pic) 

 

Note: The Update Button is disabled by default until a utility has been selected. 

 
4. The Update Done Dialog Box appears when the download is complete.  Click on OK to close 

it. 
 

                                                  (pic) 
 

Caution: Clicking on the Quit Button closes the Updater without completing any operations. 

 
 

Mount Another Server 
 
The Mount Server option connects users to additional Speiros servers, making that server's resources 
available for use. If it successful, the server will be mounted into your Speiros File Browser, making files 
available to other programs.  Any errors that occur during the process will be reported as well. 
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1. Click the Speiros Start Button and then select Mount Server in the Start Menu. 

 
 

The Speiros Login Dialolg Box appears. 
 
                                          (pic) 
 

2. Log on to another server by entering it in the Speiros Center Text Field or select one from the 
Drop-down List.  If any errors occur or the server is not available, the message will appear in 
the Status Bar. 

 
                                          (pic) 
 
 
 
 
 
 

3. Open your File Browser and the new server will be listed as another directory. 
 
                                (pic) 
 
 

Customize the Appearance of the Speiros Bar 
 

1. Click the Speiros Start Button and then select Settings in the Start Menu. 
 
 

The Settings Dialog Box appears. 
 
                                            (pic) 
 

Modify Your Speiros Bar Orientation 
 

1. On the Settings Dialog Box, select the Orientation Radio Button you prefer in the Speiros Bar 
Orientation Box (the default is vertical). 

 

Modify the Size of Your Speiros Bar 
 

1. On the Settings Dialog Box, select the number of items you want to appear from the Drop-
down List in the List Size Box (the default is 3). 

 

Show or Hide File Names on Your Speiros Bar 
 

1. On the Settings Dialog Box, click on the Show File Names Check Box if you want the file 
names to be shown.  A check mark appears in the box to enable the option. 

 
2. On the Settings Dialog Box, click on the Check Box again if you want the files names to be 

hidden.  The check mark disappears and disables the option (the default setting). 
 

Request Confirmation Before Exiting Speiros 
 

1. On the Settings Dialog Box, click on the Confirm Before Exiting Speiros Check Box.  A check 
mark appears in the box to enable the option. 
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Using the Task Monitor 
 
The Task Monitor shows all of your active "tasks", which are the resources and applications you are 
currently running.  From there, you can end individual tasks as well as launch them. 
 
To access the Task Monitor: 
 

1. Click the Speiros Start Button, select Utilities, and then Task Monitor. 
 
 

The Task Monitor appears. 
 
                         (pic) 
 
 

Monitor or Check the Status of a Task 
 

1. In the Task Monitor, locate the task under the Task Name Column and follow the bar across to 
the Status Column to see the status. 

 
For example, in the picture below, the Task Monitor shows the Task Tool and the File Browser are 
running. 

 
                        (pic) 
 

Note: Currently, the only status reported by the Task Monitor is "running".  If a task has been terminated, 
it disappears from the list. 

 
 
 
 

Terminate a Task or Resource 
 

1. In the Task Monitor, click on the running task you wish to terminate.  The task will appear 
highlighted. 

 
                          (pic) 
 

Note: If you decide not to terminate the task, click on the task again to de-select it.  The highlight will 
disappear. 

 
2. Click on the Kill Button to terminate the task, or on the File Menu, select Kill. 

 
                           (pic) 
 

The task is removed from the Task Monitor and the utility that was running is teminated. 
 
                           (pic) 
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Using the Speiros File Browser 
 
The Speiros File Browser gives you the capability to manage your file systems on local and remote 
servers.  
 
To access the Speiros File Browser: 
 

1. Click the Speiros Start Button, select Utilities, and then File Browser. 
                                   
 

The Speiros File Browser appears in the Split View.  
 
                                     (pic) 
 

Note: The Split View shown above is the default.  All the operations involved in working with the File 
Browser applies to both panes. 

 

Managing Files and Folders 
 

Display the Contents of the Home Directory 
 

1. In the Speiros File Browser, locate and select the Home Folder under your Speiros Server. 
 
                                      (pic) 
 

2. You can: 
 

•••• Double-click on the Folder 
or 

•••• Click on the Open Icon on the Toolbar 
or 

•••• On the File Menu, select Open 
or 

•••• Right-click to open the Alt-Menu and select Open 
 

Display the Contents of Any File or Folder 
 

1. In the Speiros File Browser, select the file or folder you wish to open. 
 
2. You can: 
 

•••• Double-click on the File or Folder 
or 

•••• Click on the Open Icon on the Toolbar 
or 

•••• On the File Menu, select Open 
or 

•••• Right-click to open the Alt-Menu and select Open 
 

Open a Document or Program File 
 

1. In the Speiros File Browser, select the file or folder you wish to open. 
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2. You can: 
 

•••• Double-click on the File or Folder 
or 

•••• Click on the Open Icon on the Toolbar 
or 

•••• On the File Menu, select Open 
or 

•••• Right-click to open the Alt-Menu and select Open 
 

Copy Resources, Files, or Folders to Other Folders, Drives, or Servers 
 

1. In the Speiros File Browser, select the file or folder you wish to copy. 
 
2. You can: 
 

•••• Click on the Copy Icon on the Toolbar 
or 

•••• On the Edit Menu, select Copy 
or 

•••• Right-click to open the Alt-Menu and select Copy 
 
3. Select the destination folder, drive or server. 
 
4. You can: 
 

•••• Click on the Paste Icon on the Toolbar 
or 

•••• On the Edit Menu, select Paste 
or 

•••• Right-click to open the Alt-menu and select Paste 
 

A Confirmation Dialog Box appears. 
 
                                          (pic) 
 

5. Click on the OK Button to continue or the Cancel Button to end the operation. 
 

Create a New Folder 
 

1. In the Speiros File Browser, select the folder you wish the new folder to appear under. 
 
2. You can: 
 

•••• Click on the New Folder Icon on the Toolbar 
or 

•••• On the File Menu, select New Folder 
 

Rename a File or Folder 
 

1. In the Speiros File Browser, select the file or folder you wish to rename. 
 
2. You can: 
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•••• Click on the Rename Icon on the Toolbar 
or 

•••• On the File Menu, select Rename 
or 

•••• Right-click to open the Alt-Menu and select Rename 
 

Find a File or Folder 
 

1. In the Speiros File Browser File Menu, select Search. 
 
The Search Dialog Box appears. 

 
 
                                                 (pic) 
 

2. Type in the name of the file or folder you wish to find in the File Name Text Field. 
 
3. Select the drive you wish to search in from the Drop-Down List. 
 
4. Click on the Search Button.  The results are displayed in the Results Box. 

 
                                             (pic) 
 

Note: Clicking on the Stop Button will stop the search operation. 

 
 

Delete a File or Folder 
 

1. In the Speiros File Browser, select the file or folder you wish to delete. 
 
2. You can: 
 

•••• Click on the Delete Icon on the Toolbar 
or 

•••• On the File Menu, select Delete 
or 

•••• Right-click to open the Alt-Menu and select Delete 
 

View File Properties 
 

1. In the Speiros File Browser, select the file or folder you wish to view properties. 
 
2. You can: 
 

•••• On the File Menu, select Properties 
or 

•••• Right-click to open the Alt-Menu and select Properties 
 

Open a Duplicate Window 
 

1. In the Speiros File Browser, select the resource you wish to duplicate. 
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2. You can: 
 

•••• Double-click on the File or Resource 
or 

•••• Click on the Open Icon on the Toolbar 
or 

•••• On the File Menu, select Open 
or 

•••• Right-click to open the Alt-Menu and select Open 
 
 

Customize the File Browser Display 
 
While its function is the same as most file browsers, the Speiros File Browser is unique in that it allows 
you to customize it to the environment you are most comfortable with.  The Split View emulates a 
windows style browser, while Mac users are use to a Tree View.  A very basic Content View is available 
for those that are new to the internet, or you can create your own Custom view by combining elements 
from all three views. 
 

Selecting the File Browser View 
 

1. In the Speiros File Browser View Menu, you can select from three different Views or you can 
create a Custom View. 

 
                                (pic) 
 
 

The Tree View 
 

The Tree View has one pane, the Directory Tree. 
 
                                 (pic) 
 

Resize the Columns in the Directory Tree 
 

1. In the Speiros File Browser, click on the Column Arrow for the direction you wish to resize the 
columns. 

 

The Split View  
 
The Split View has two panes, the Directory Tree and the Contents Tray. 
 
                                 (pic) 
 

Note: The Split View is the default until you select otherwise. 

 

Resize the Panes in the Split View 
 

1. In the Speiros File Browser, you can: 
 

•••• Drag the Scrolling Divider between the Panes 
or 

•••• Click on the Direction Arrows located at the top of the Scrolling Divider 
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The Contents Tray View 
 
The Contents Tray View has one pane, the Contents Tray Pane. 
 
                                 (pic) 
 

Customize the Contents Tray Display 
 
1. In the Speiros File Browser View Menu, you can select from three different Content Tray 

Options: 
 

δδδδ Detail 

δδδδ Column 

δδδδ Icon 
 
The Icon View displays the individual files and folders as icons. 

 
                                 (pic) 
 

Note: The Icon View is the default until you select otherwise. 

 
 

The Details View 
 
The Details View displays all the details regarding a file or folder. 
 

Details include: 
 

δδδδ Size 

δδδδ MIME type 

δδδδ Modification date 
 
                                 (pic) 
 
 

The Column View 
 
The Column View organizes the files and folders into columns. 
 
                                 (pic) 
 
 

Show or Hide the Toolbar 
 
The File Browser also gives you the option to show or hide the toolbar. 
 

1. In the Speiros File Browser View Menu, select Hide Toolbar. 
 
                                (pic) 
 

The Toolbar disappears from the File Browser. 
 
                                (pic) 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

22 

 
1. In the Speiros File Browser View Menu, select Show Toolbar to bring it back. 
 
                                (pic) 
 

Creating a Custom View 
 

1. In the Speiros File Browser View Menu, select Custom View. 
 

The View Option Dialog Box appears. 
 
                                (pic) 
 

2. Select the View Radio Button you prefer in the View Box (the default is Show Both Panes). 
 
 

3. Click on the Show Files or Folders Check Box you prefer in the Show Box (more then one 
option can be checked). 

 
4. Click on the OK Button to accept the changes or the Cancel Button to close the Dialog Box 

without making changes. 
 
 

Using the Catalog Browser 
 
You use the Catalog Browser to view and interact with the contents of a catalog, which is a hierarchical 
collection of resources or applications known as aliases.  It is a link between the resource or application 
and its associated URL.  An alias can link to a web page or any other destination on the Internet.  Speiros 
utilizes aliases to access resources or run applications. 
 
A Speiros Catalog is an organized collection of aliases.  The aliases within the catalog are organized by 
categories.  For example, in the picture below, Examples, Epluribus and AMEX are all categories under 
the Catalog Directory.  The categories reflect the folder directory structure beneath the catalog's 
directory.  There are a wide variety of catalogs, including server catalogs, a personal catalog you can 
create, and web site catalogs. 
 
To access the Catalog Browser: 
 

1. Click the Speiros Start Button, select Utilities, and then Catalog Browser. 
 

The Catalog Browser appears. 
 
                                 (pic) 
 
 
 
 
 
                                   (pic) 
 

Parts of the Catalog Browser include: 
 

δδδδ Category Button- The Button is located in the upper left-hand corner of the Category Navigator 
and to the left of the Parent Category Navigator.  It and displays the name 
of the last category opened.  

Category Button � 

Category Navigator � 

 Parent Category Navigator 

I Info Board 
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δδδδ Category Navigator- The Navigator is located directly below the Category Button and to the left 
of the Info Board and Advertisement Panes.  It shows the items contained 
in the category displayed on the Category Button as an Icon Buttons with 
Arrows for submenus. 

δδδδ Parent Category Navigator- The Navigator is located directly above the Info Board.  It shows 
the Parent Category path of the item open in the Info Board. 

δδδδ Info Board- This pane displays attributes and information regarding the selected Category or 
Alias in the Category Navigator. 

 

Selecting an Alias 
 

1. On the Catalog Browser Category Navigator, click on a Category's Arrow Button. 
 
A Submenu opens showing the next level of categories. 

 
                                 (pic) 
 
2. Drag across the Submenus of Categories down to the Alias you want to select. 
 

Information on the Alias appears in the Info Board along with an Alias Icon. 
 
                                  (pic) 
 

Note: The Category Button has changed to reflect the last category opened and that the Category 
Navigator shows the list of Aliases under it that were originally in the submenu. 

 
Information on the Alias includes: 
 

δδδδ The name 

δδδδ The author 

δδδδ The version 

δδδδ The date it was created 

δδδδ The Alias's Home Page 

δδδδ Actions the alias can perform 
 

Note: If a home page exists for the alias, it is displayed in a scrollable text area below the other 
descriptive information. 

 

Navigating Through the Categories 
 

Navigate Up 1 Category 
 

1. In the Catalog Browser, you can: 
 

•••• Click on the Up 1 Category Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Up One Category 
 
                                (pic) 
 

Go to the Top 
 

1. In the Catalog Browser, you can: 
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•••• Click on the Go to Top Category Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Go to Top Category Icon 
or 

•••• Click on the Category Button and select the Category from the Submenu.  
 
                                     (pic) 
 

Use the Parent Category Navigator 
 

1. On the Catalog Browser Parent Category Navigator, click on the Category you wish to go back to. 
 
For example, in the picture below, you see Examples> Games> in the Parent Category Navigator.  
These are the Parent Categories for the 3dgolf.alias which is open in the Info Board. 

 
 
                                (pic) 
 

Clicking on Games> moved the Category up one level to Examples> which opens the Examples 
Category in the Info Board.  Currently there is no Category Description provided for Examples. 

 
                               (pic) 
 

Display Alias or Category Information 
 

1. In the Catalog Browser, you can: 
 

•••• Click on the Show Info Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Show Info 
 
                                (pic) 

Make the Current Catalog the Default 
 

1. In the Catalog Browser, you can: 
 

•••• Click on the Set as Default Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Set as Default 
 

Reload All of the Alias or Category Information 
 

1. In the Catalog Browser, you can: 
 

•••• Click on the Refresh Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Refresh 
 

Working With Your Personal Catalog 
 

Open Your Personal Catalog 
 

1. In the Speiros Catalog Browser File Menu, select Open Personal Catalog. 
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                                     (pic) 
 

Your Personal Catalog appears. 
 
                                     (pic) 
 

Note: Several things change in your Personal Catalog that you would not see in any other Catalog.  Your 
user name should appear in the Title Bar, the Category Navigator only contains the one Category, 
Bookmarks and the Add to my Personal Catalog Icon on the Toolbar has changed to the Remove from 
My Personal Catalog Icon. 

 

Adding Aliases to Your Personal Catalog 
 

When an Alias is open in any Catalog, you can add it to your Personal Catalog. 
 

For example, in the picture below, the 3dgolf Alias is open. 
 

                               (pic) 
 

To add an alias to your Personal Catalog: 
 

1. In the Catalog Browser, you can: 
 

•••• Click on the Add to my Personal Catalog Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Add to my Personal Catalog 
 
                               (pic) 
 

The Save Dialog Box appears with the 3dgolf Alias in the File Name Field. 
 

Note: The Directory structure here is the same as you would find in your File Browser.  You can also 
place aliases directly in the Catalog Directory. 

 
                                  (pic) 
 

2. Click on the Save Button to save the Alias in the Catalog Directory. 
 

Note: The Dialog Box closes automatically when the Alias has been saved. 

 
 
 
 
 
 
 

The 3dgolf Alias now appears directly on the Category Navigator. 
 
                               (pic) 
 

The next time you open the Save Dialog Box, the Alias also appears in the Contents Tray. 
 
                                   (pic) 
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Note: Clicking on the Cancel Button closes the Dialog Box without completing the operation. 

 
3. If you want the Alias to appear as a subcategory under Bookmarks, double-click on the 

Bookmarks Folder Icon in the Contents Tray. 
 
 
 
 
 
 
 
 

The Bookmarks Folder appears in the Directory Drop-down List of the Save Dialog Box. 
 
                                  (pic) 
 

4. Click on the Save Button to save the Alias in the Bookmark Directory. 
 

The 3dgolf Alias now appears as a Subcategory of Bookmarks. 
 
                               (pic) 
 
 

Create a New Category 
 
To create a new Category: 
 

1. In the Save Dialog Box, click on the Create New Folder Icon. 
 
The Create Folder Dialog Box appears. 

 
                                                     (pic) 
 

2. Enter the name of the new folder in the Text Field and then click on the OK Button.  In the 
example above, Special, was entered. 

 
The Special Directory now appears in the Contents Tray of the Save Dialog Box. 

 
                                     (pic) 
 

The Save Dialog Box also includes the following icons: 
 

δδδδ Up 1 Level- Opens the Drop-down Directory List to navigate up the file structure 

δδδδ Home- Takes you to the top of the Directory List 

δδδδ List- Changes the Contents Tray display to List View 

δδδδ Details- Changes the Contents Tray display to Details View 
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And as a new Category on the Category Navigator. 

 
                                (pic) 
 

Note: A new Category can also be done by adding folders or directories under your Catalog Directory in 
the File Browser. 

 
 

Removing an Alias From Your Personal Catalog 
 
You can remove any aliases from your Personal Catalog. 
 

1. Select the Alias you wish to remove. 
 

2. In the Personal Catalog Browser, you can: 
 

•••• Click on the Remove from my Personal Catalog Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Remove from my Personal Catalog 
 
                               (pic) 
 

The Delete Dialog Box appears with the selected Alias in the File Name Field. 
 
                                   (pic) 
 

Note: The Delete Dialog Box functions the same as the Save Dialog Box. 

 
2. Click on the Delete Button to delete the Alias in the Catalog Directory. 
 
The Alias no longer appears in your Personal Catalog.  

 
                            (pic) 
 

And does not appear in the Contents Tray. 
 
                                (pic) 
 

Changing Passwords 
 

1. Click the Speiros Start Button, select Utilities, and then Change Password. 
 
 

The Change Password Dialog Box appears. 
 
                                                 (pic) 
 

The default fields display the following information: 
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δδδδ Host Text Field- Displays the Host name of the server Speiros is currently running on (the 
Host the you were logged into previously is the default). 

δδδδ Port Text Field- Displays the Port on which the server is running. 

δδδδ Logon Text Field- Displays the logon id for the password being changed.  
 

Note: The utilities in the text fields can be changed.  You can change passwords on a different host or 
even as a different user and change other passwords. 

 
1. Enter your current password in the Current Password Text Field. 
 
2. Enter your new password in the New Password Text Field. 
 
3. Re-enter your new password in the Re-enter Password Text Field for confirmation. 

 
                                                 (pic) 
 

4. Click on the Update Button to complete the operation. 
 

The "Password updated successfully" message appears in the Status Bar.  Any other error 
messages would be reported there as well. 

 
                                                 (pic) 
 

Note: Clicking on the Close Button closes the Tool without completing any operations.  Clicking on the 
Reset Button clears all the current fields as well as any messages in the Status Bar. 

 
 
 

Launching Aliases 
 

You can launch an alias from several different applications in Speiros.  The launched alias will open in a 
new window (see Using the Catalog Browser for a definition of an alias). 
 

Using the Speiros Bar 
 

1. Double-click on the Buttons on the Speiros Bar to launch that alias. 
 

For example, in the picture below, clicking on the Damango Button will launch the Damango web 
site. 

 
                                                                           (pic) 
 

Using the Task Monitor 
 

1. Type in the URL of the alias you wish to launch in the Input Task URL Text Field.  The URL 
must contain the classpath and the alias extension. 

 
                         (pic) 
 
Speiros utilizes the Java classpath instead of the common http protocol used by web browsers for 
launching URLs.  For example, http:/app.cyrus.net becomes classpath:/app.cyrus.net. 
 

2. Click on the Launch Button. 
 

The alias is opened in a new window and appears as a new task in the Task Monitor. 



v1.0 USER GUIDE- INTERNAL USE ONLY 
(propriety property of Julie King: writersblend.com, writehearted@gmail.com) 

29 

 

Using the File Browser 
 

1. Select the Alias you wish to launch in either pane. 
 
                               (pic) 
 

2. Double-click on it to open the Alias. 
 
 
 

Using the Catalog Browser 
 

1. Select the Alias you wish to launch (see Selecting an Alias in Using the Catalog Browser). 
 
                                  (pic) 
 

2. You can: 
 

•••• Double-click on the Alias Icon on the Info Board. 
or 

•••• Click on the Launch Icon on the Toolbar. 
or 

•••• On the Catalog Menu, select Launch App 
 
                              (pic) 
 
 

Adding Favorite Aliases to Your Speiros Bar 
 
Speiros allows you to save your favorite aliases as icons on your Speiros Bar for quick and easy access.  
This can be done from several different applications. 
 

Using the Speiros Bar 
 

1. Click the Speiros Start Button and then select Settings in the Start Menu. 
 
 

The Settings Dialog Box appears. 
 
                                            (pic) 
 

2. Click on the Open Desktop Folder Button. 
 

 
 
 
 
 
 
 
 
 

The File Browser appears. 
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                               (pic) 
 

3. Locate the Desktop Folder on your Speiros Server. 
 
4. Select the favorites files you want in the File Browser by drag-and-dropping to the Desktop 

Folder. 
 

Note: The Desktop Folder is where information for your Speiros Bar is kept.  

 

Using the File Browser 
 

1. Locate the Desktop Folder on your Speiros Server. 
 

                             (pic) 
 

2. Select the favorites files you want in the File Browser by moving or coping it to the Desktop 
Folder. 

 

Using the Catalog Browser 
 

1. Select the Alias you wish to save (see Selecting an Alias in Using the Catalog Browser). 
 
                                (pic) 
 
2. You can: 
 

•••• Click on the Dock Icon on the Toolbar 
or 

•••• On the Catalog Menu, select Dock Alias 
 
 
 
 

 
 
 
 


